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When to Submit Your Rosters to DECAL 

Email Notification 

DECAL will send you an email notification when rosters are open for entry.  The email will 

provide the roster count date and the roster due date.  You can begin Roster Entry at this 

time, but cannot submit the roster until the count date. 

PANDA Critical Reporting Dates Document 

The roster count dates are included in the PANDA Critical Reporting Dates document that 

you read and acknowledged as part of the application process. You may open and print your 

application documents at any time during the school year. 

To view the PANDA Critical Reporting Dates document: 

1. From the main menu, choose Enter Application. Your application opens to the Read 

Me Files tab. 

 

2. Click the PANDA Critical Reporting Dates link in the Pre-K Application 

Mandatory Documents section of the Read Me Files tab. The document opens in a 

separate browser window. 

3. When you are finished with the document, close the window. 
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Who to Submit on Your Rosters to DECAL 

The number of students enrolled in a class on any date may not exceed the number of 

students approved in your contract unless DECAL has granted a class size waiver. If 

your roster includes both un-enrolled students and new students, their enrollment dates 

cannot overlap so that the total number of students enrolled on any given date during 

the roster cycle exceeds the number of approved students. 

 

Your roster should include: 

 New students that have met all Georgia Pre-K enrollment requirements and have 

attended for at least 1 day. 

 All students enrolled in your program on the count date even if the student is absent 

on the count date. 

 Students who un-enrolled from your program since the previous roster count date.  

These students should now have end dates. 

 The lead teacher even if the class is being led by a substitute on the count date. A lead 

teacher is required all days the class is in operation.  If there is currently no lead 

teacher, enter the substitute as the lead teacher. 

 The assistant teacher even if the assistant teacher is absent on the count date. Each 

class must have an assistant teacher all days the class is in operation.  If there is 

currently no assistant teacher, enter the substitute as the assistant teacher.   

Note:   You have up to three (3) weeks to replace a teacher who is leaving your class.  
Expectations are this three (3) week period will allow you time to replace your teacher 
with qualified staff (BA or higher credential for Lead and CDA or higher credential of 
Assistant).  If you cannot find a properly credentialed replacement, your long-term 
substitute will be paid at the insufficient credential rate.  Submit long-term sub request to 
consultant for approval.    

Ways to Submit Your Rosters to DECAL 

There are two ways for PANDA users to submit their rosters to DECAL. 

 You can enter your rosters online. If you use this method, you will manually enter 

each student and teacher into the online roster form, and then submit the form to 

DECAL. Instructions begin on page 5. 

 If you have multiple sites and classes, you can bypass the data entry process and 

submit your rosters to DECAL using the roster upload process. The upload process is 

only applicable during Roster Cycle 1 of each school year.  Instructions begin on 

page 13. 
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Entering Your Roster Via the Online Process 

Process Overview 

Online roster entry is a three-step process. If you choose to submit your rosters using this 

method, you will: 

1. Select a site and class. 

2. Enter and save lead teacher, assistant teacher, and student information. 

3. Submit your completed rosters to DECAL 

 

Selecting a Site and Class for Roster Data Entry 

You can begin the roster data entry process when you receive your notification from 

DECAL. You cannot enter rosters until you receive this notification. 

1. From the main menu choose View/Edit Roster. The Roster Site List screen displays. 

 

 

2. To choose a site, click on top of the site name that you want to view. The Roster 

Class List screen displays.  
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If you are a New Provider, no teacher names will display here and you will need to enter this 

information.   If you are a Returning Provider, the Teacher data will be carried over 

automatically from the last Roster of the previous school year to Roster 1 of the current 

school year.  You will only need to make any necessary changes in personnel or in 

credentials.  When a change is made in Panda to the Teacher data, Appendix N – Teacher 

Notification Form, is automatically generated and emailed to BFTS.  You can print it out 

prior to pressing the button to confirm the changes made are correct. 

Please help ensure that your teachers have already registered in the Professional 

Development Registry (PDR) and that they know to mail the supporting credential 

documentation to the below address instead of mailing it to DECAL: 

 Georgia Professional Standards Commission 

 Professional Development Registry 

 200 Piedmont Avenue 

 Suite 1702 

 Atlanta, GA 30334-9032 

 

3. To choose a class, click on top of the desired Class ID field. The Roster Detail 

screen displays for the selected class. 
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Roster Data Entry  

The Roster Detail screen lists the lead teacher, assistant teacher, and students included in 

your previous roster.     If this is the first roster cycle of the school year, no student names 

will display as the student data is only rolled over from Roster to Roster but not from Year to 

Year.  You will need to enter the student information on Roster 1 and then update it each 

subsequent roster.   

 

 

 

Enter/Update Lead and Assistant Teacher Information 

1. To add a lead or assistant teacher, click the button. To edit a current lead 

or assistant teacher record, click on top of the teacher's name. The Teacher 

Information screen displays.    
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2. In the Teacher Name fields, enter the lead teacher's first and last names. If the 

lead teacher is certified, be sure to enter the lead teacher’s first and last names 

exactly as they appear on the teaching certificate. The teacher's name and social 

security number will be used to confirm his or her certification with the GA 

Professional Standards Commission (PSC) and Professional Development 

Registry (PDR). 

3. In the SSN field, enter the teacher's social security number.  Please verify your 

SS#’s after entry for correctness. 

4. From the Teacher Credential drop-down list, select the teacher's current 

credential.  

5. Select the teacher's training level from the drop-down list.   This applies to 

certified teachers only. 

6. Enter the years of teaching experience in Creditable Years of Experience field.  

Creditable years are defined as total years providing direct care and education to 

ECE/ELEM classrooms. 

7. In the Begin Date in Class field, enter the date that the teacher began teaching 

this class.  MM/DD/YYYY.  Note: This date must be in the current school year.  

The roster start date is 08/01/YYYY so returning teachers default to that start 

date. 

8. If the teacher has left since the last roster, enter the teacher's last day in the End 

Date in Class field.  MM/DD/YYYY.   Note: This date must be in the current 

school year.  All teachers on Roster 4 of last school year were automatically 

rolled over to Roster 1 of this school year.  If the teacher did not return this school 
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year, simply enter an end date for them of 8/1/2015.  This field is also applicable 

if the teacher is being closed and re-entered with a higher credential.  The End 

Date cannot be a future date and cannot be within the previous school year.  The 

End Date must be the day before the Start Date for the new teacher even if 

weekend dates are included.  (i.e.  If the teacher currently listed on the roster left 

on Friday, her replacement teacher must have a Start Date of Saturday OR you 

can set the current teacher’s End Date for Sunday and the new teacher’s Start 

Date on Monday.) 

9. Click the button. The Teacher Information screen displays summary 

information about the teacher your entered. 

 

Teacher changes are required to be updated in PANDA.  When a change is made in PANDA to the 

Teacher data, Appendix N- Teacher Notification Form is automatically generated and emailed to 

BFTS.  You can print it out prior to pressing the button to confirm the changes made are correct.  
This form is required in the event of teacher change and/or credential change during the school year.  

Failure to update teacher changes in PANDA may result in a probationary status and/or 
reduction in funding.    

  

The Professional Standards Commission (PSC) reviews and verifies all teacher credentials through the 

Professional Development Registry (PDR). Please help ensure that your teachers have registered in 
the PDR (www.pdr.decal.ga.gov) and they have sent the supporting credential documentation to the 

Georgia Professional Standards Commission (PSC) rather than to BFTS-DECAL.  Credentials other 
than degree transcripts may be faxed to the PSC at 404-232-2661, with a cover letter stating the 

PDR#.  All degree transcripts must be official and mailed to the PSC at the address below:   

Georgia Professional Standards Commission 
Professional Development Registry 

200 Piedmont Avenue, Suite 1702 

Attn: PDR (insert PDR number)  
Atlanta, GA 30334-9032 
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Enter/Update Student Information 

Each provider can enter a maximum of 22 students per class, unless DECAL has 

granted a class size waiver. Your payment will be based on the number of students 

enrolled in your class on the roster count day. Your payment may also include 

retroactive payments. These changes occur when prior month entries are changed by 

adding or withdrawing students and teachers. Absent students should be included in 

your roster if they are currently enrolled in your Pre-K program. If your roster 

includes both un-enrolled students and new students, their enrollment dates cannot 

overlap so that the total number of students enrolled on any given date during the 

roster cycle exceeds the number of approved students. 

1. To add a student, click the  button. To edit a student, click on top of the 

student's name. The Student Information screen displays.  

 

 
 

2. In the Last Name field, enter the student's last name exactly as it appears on their 

birth certificate.  Hyphens and apostrophes may be included.   

3. In the First Name field, enter the student's first name exactly as it appears on their 

birth certificate.  Hyphens, apostrophes and periods may be included. 

4. In the Middle Name field, enter the student’s middle name exactly as it appears on 

their birth certificate.  Hyphens, apostrophes and periods may be included.  If the 

student does not have a Middle Name, enter ‘NMN’ to represent No Middle Name. 
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5. If the Name Suffix field is applicable, select the appropriate Jr, Sr, II, III value from 

the drop-down list. 

6. In the Date of Birth field, enter the student's birthday exactly as it appears on their 

birth certificate.   MM/DD/YYYY. 

7. In the SSN field, enter the child's social security number.   It will be encrypted in the 

system to ensure data security.    NOTE:  Please verify your SS#’s after entry for 

correctness. 

If SSN is omitted, a waiver signed by the parents/guardian is required to be on file 

at the site and will need to be provided to DECAL upon request if needed. 
 

8. If the SSN is not entered, the SSN Waiver Reason section will be displayed at the 

bottom of the screen.  Please select the appropriate checkbox next to the Waiver 

Reason specified by the Parent on the SSN Waiver Form (Appendix P).   If they 

selected ‘I do not choose to provide the SSN because …’, then also enter the Waiver 

Reason Detail field exactly as the parent entered it on the Waiver Form. 

NOTE:  To add a social security number after the student information has been saved, 

click POPULATE SSN, enter the social security number and click ‘Save’. 
 

9. From the Gender drop-down list, select the child's gender.  Male, Female. 
 

10. If the child is from a twin or higher-order multiple birth and the child’s siblings also 

attend Pre-K, select the number of children from the Multiple Birth drop-down list. 

If the child was born from a single birth, select 1.  If the child was born from a twin 

birth, select 2. 
 

11. If the center transports the child to and from Pre-K, select Yes from the 

Transportation drop-down list. If the child is not transported by the Center, select 

No.   
 

12.  If the parent checked any boxes on question #6 on the Roster Information Form and 

you have documentation of the child’s participation in the program on file for review, 

select Category 1 from the Socio/Economic drop-down list.  Otherwise, select 

Category 2.    

CORRECTING TRANSPORTATION & CATEGORY 

If you need to edit these fields prior to submission of Roster 1, you can click on the 

student’s name and enter the corrected values.   If you need to edit these fields after 

Roster 1 has been submitted, you can now easily edit them on subsequent rosters by 

clicking on the ‘Chg Trans/Socio Economic’ button.  Simply enter the corrected 

values and the system will prompt you for an effective date button for each field you 

change along with guidelines regarding how to determine the correct effective date.   

You no longer need to close the student and re-add the student as was required in the 

past.   
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13. From the Ethnicity drop-down list, select the student's ethnicity.  Hispanic/Latino or 

Not Hispanic/Latino. 

14. From the Race choices displayed, select all values that apply to this student.  

American Indian/Alaskan Native, Asian, Black or African American, Native 

Hawaiian or Other Pacific Islander, White. 

15. From the Limited Language Proficiency drop-down list, select Yes if the student 

has difficulty speaking the English language. Select No if the child has no known 

language proficiency issues. 

16. If an Individual Education Plan (IEP) is in place for the child, select Yes from the 

IEP drop-down list. Select No if the child does not have an IEP. 

NOTE:  To change IEP, LLP or Gender, click directly on top of the value in the field 

that needs to be updated, make the change, and save.    

 

 

17. From the Funding drop-down list, select the source of Pre-K funds:  Lottery or 

Blended.  Select ‘Blended’ if the class receives both Head Start and Pre-K funding.  

Select ‘Lottery’ if the class only receives Pre-K funding. 

18. In the Begin Date in Class field, enter the child's first day in Pre-K.  

MM/DD/YYYY. 

19. In the End Date in Class field, enter the child's last day in Pre-K, if applicable.  This 

date is not entered until the child has un-enrolled and cannot be after the count date of 

the current roster.  The End Date in Class cannot be a future date.  MM/DD/YYYY. 

20. Click the button. 

21. Click the  button to return to the Roster Form screen, or click the  

button to add another student to the roster. 
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Entering Your Roster via the Upload Process 

Process Overview 

Typically, the upload process is used by Providers with multiple sites/classes, but it can also be a 

time-saver for those who have only one site/class.  A file should be created for each site and 

should include all students for all classes at that site.  The upload process is only applicable to 

the first roster cycle of the school year. 

Since the files are created outside of PANDA, an advantage to using the upload process is that 

the files can be prepared prior to the begin date of Roster Cycle 1.  The upload files will be easy 

to create in Microsoft Excel by using the DECAL template and following the steps outlined 

below.     

The Upload Roster Process is a three-step process just like the Online Entry Process.  If you 

choose to submit your first roster using the upload method, you will: 

1. Create student upload file(s) using one of these two methods: 

- By using the DECAL template from the BFTS website 

- By using the pre-populated template from your Local School System(LSS) 

data vendor.   (This method will be available through Infinite Campus 

beginning in 2015-16; other vendors will be phased in for 2016-17.) 

 

2. Upload the completed student roster file(s) and resolve any errors 

3. Submit your completed rosters to DECAL 

 

Creating an Upload File Using the DECAL Template 

1. Save the Student Roster template by clicking on the blue  

button on the PANDA login page, then selecting the ‘PANDA Student Roster Template’ 

option from the Document List.   Save this xls file to a folder on your computer. 

2. Double-click on the xls file you just saved, launching Microsoft Excel.  

3. Follow the instructions shown in the header rows highlighted in red and begin entering 

your data on line 8 of the excel worksheet. 

As you tab through each column, a popup will be displayed clarifying what each column 

represents.     Where applicable, a dropdown has been defined on the column if there is a 

restricted list of valid values allowed.  You will need to verify your Site Id and Class Id 

values each year, as the Class Id values change each school year. 

 

The columns included in the template are listed below:   
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a) In Column A, enter the Site Id where the class you are uploading is located.   To 

verify your Site Id, click on ‘View/Edit Roster’ and the Site Id will be included on the 

first screen that is displayed, as shown below: 

 

 

b) In Column B, enter the Class Id.   To determine your Class Id, click on the yellow 

box in the above screenprint next to the desired Site Name and the Class Ids for each 

class at that Site will be included on the next screen displayed, as shown below: 
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c) In Column C, enter the student’s last name exactly as it appears on their birth 

certificate.   The student’s last name must have two or more letters, and may include 

hyphens and apostrophes. Example: D’Angelo, Smith-Kline. 

d) In Column D, enter the student’s first name exactly as it appears on their birth 

certificate. The student’s first name must have at least two letters, and can include 

two names separated by hyphens, apostrophes, spaces, or periods. Examples: Jean-

Paul, Da’Shandra, T.J. 

e) In Column E, enter the student’s social security number using the following format: 

123456789 without dashes. It will be encrypted in the system to ensure data security. 

If you omit the student’s social security number, a signed affidavit must be on file at 

the student’s site.  Please verify your SS#’s after entry for correctness. 

f) In Column F, select the student’s gender from the dropdown list:  

           M(male)  

           F(female) 

g) In Column G, enter the student’s date of birth exactly as it appears on their birth 

certificate using the format: MM/DD/YYYY. 

h) In Column H, if the child is from a twin or higher-order multiple birth, select the 

number of children from the Multiple Birth drop-down list. If the child was born 

from a single birth, select 1.  If the child was born from a twin birth, select 2. 

                       1(single) 

           2(twin) 

           3(triplet) 

           4(quadruplet) 

           … etc. 

i) In Column I, select the student’s socio-economic indicator, which is based on 

whether the parent checked any boxes on question #6 on the Roster Information 

Form, from the drop-down list: 

          1(category 1) 

          2(category 2) 

j) In Column J, select the student’s transportation indicator from the drop-down list.  

If the Center transports the child to and from Pre-K, select ‘Yes’.   

         Yes 

         No 

k) In Column K, select the student’s ethnicity from the drop-down list: 

         Hispanic/Latino 

         Not Hispanic/Latino 

 

l) In Column L, select the limited language proficiency indicator from the drop-down 

list.   If the child has difficulty speaking the English language, select ‘Yes’. 

         Yes 

         No 
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m) In Column M, select the student’s Individual Education Plan indicator from the 

drop-down list.  If the child has an IEP, select Yes: 

         Yes 

         No 

n) In Column N, select the class funding source from the drop-down list.  Select 

‘Blended’ if the class receives both Head Start and Pre-K funding.  Select ‘Lottery’ if 

the class only receives Pre-K funding. 

         Lottery 

         Blended 

o) In Column O, enter the student’s effective begin date in the class (MM/DD/YYYY) 

p) In Column P, enter the student’s effective end date in the class (MM/DD/YYYY) if 

applicable.  This date is not entered until the child has un-enrolled and cannot be after 

the count date of the current roster.  The end date cannot be a future date. 

q) In Column Q, enter the student’s Middle Name exactly as it appears on their birth 

certificate.  The student’s middle name may include hyphens and apostrophes.  If the 

student does not have a Middle Name, enter ‘NMN’ to represent No Middle Name. 

r) In Column R, select the student’s Name Suffix, if applicable, from the drop-down 

list: 

         Jr 

         Sr 

         II 

         III 

s) In Column S, if the SSN was not provided, enter the Waiver Reason Code 

corresponding with the reason selected on the Waiver by the Parent: 

         1 = I need help in obtaining an SSN. 

         2 = I need help replacing a lost SSN. 

         3 = I am awaiting a replacement SSN and will provide when it arrives. 

         4 = I forgot to bring the SSN and will provide within 30 days. 

         5 = I choose not to provide the SSN because …. 

t) In Column T, if the Waiver Reason Code = 5, enter the Waiver Reason Detail 

which is the handwritten reason given by the Parent on the SSN Waiver Form. 

u) In Column U, select the appropriate Yes/No indicator from the drop-down list to 

indicate whether the race of American Indian/Alaskan Native is applicable to this 

student. 

v) In Column V, select the appropriate Yes/No indicator from the drop-down list to 

indicate whether the race of Asian is applicable to this student. 

w) In Column W, select the appropriate Yes/No indicator from the drop-down list to 

indicate whether the race of Black or African American is applicable to this student. 

x) In Column X, select the appropriate Yes/No indicator from the drop-down list to 

indicate whether the race of Native Hawaiian or Other Pacific Islander is 

applicable to this student. 
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y) In Column Y, select the appropriate Yes/No indicator from the drop-down list to 

indicate whether the race of White is applicable to this student. 

z) In Column Z, enter the student’s 10 digit GTID.  For school year 2015-16, this value 

will be pre-populated for all public schools currently using Infinite Campus.   All 

other public schools and all private providers should leave this field blank. 

 

NOTE: in columns U-Y, you may indicate ‘Yes’ for as many races as are applicable to 

this student.  You must indicate ‘Yes’ for at least one race value. 

 

4. Repeat step 3 for each student.  After all students at this site have been entered, delete the 

red and yellow highlighted rows. The first row in the file is now your first student. 

 

Creating an Upload File Using the Pre-Populated LSS Template 

1. Follow the instructions received from your specific LSS data vendor to create a pre-

populated Excel file for each of your Pre-K sites.   Save each xls file to a folder on your 

computer. 

2. Double-click on the xls file you just saved, launching Microsoft Excel.  

3. Verify the data shown and populate the specific Pre-K fields listed below for each child: 

  

a) In Column A, verify that the Site Id displayed is correct based on where the class 

you are uploading is located.  If needed, edit this column to reflect the correct value. 

To verify your Site Id, click on ‘View/Edit Roster’ and the Site Id will be included on 

the first screen that is displayed, as shown below: 
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b) In Column B, enter the Class Id.   To determine your Class Id, click on the yellow 

box in the above screenprint next to the desired Site Name and the Class Ids for each 

class at that Site will be included on the next screen displayed, as shown below:  You 

will need to verify your Class Id values each year, as the Class Id values change 

each school year 

 

c) In Column H, if the child is from a twin or higher-order multiple birth, enter the total 

number of children from this pregnancy as the Multiple Birth value. If the child was 

born from a single birth, enter ‘1’.  If the child was born from a twin birth, select ‘2’. 

                       1(single) 

           2(twin) 

           3(triplet) 

           4(quadruplet) 

           … etc. 

d) In Column I, enter the student’s socio-economic indicator, which is based on 

whether the parent checked any boxes on question #6 on the Roster Information 

Form: 

          1(category 1) 

          2(category 2) 

e) In Column J, enter the student’s transportation indicator.  If the Center transports 

the child to and from Pre-K, enter ‘Y’.   

         Y = Yes 

         N = No 
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f) In Column L, verify that the limited language proficiency indicator displayed is 

correct and edit this field if needed.   If a child has difficulty speaking English, enter 

‘Y’. 

                    Y = Yes 

                 N = No 

 

g) In Column M, verify that the student’s Individual Education Plan indicator 

displayed is correct and edit this field if needed.  If they have an IEP, enter ‘Y’. 

        Y = Yes 

        N = No 

           

h) In Column N, verify that the class funding source displayed is correct and edit this 

field if needed.   Enter ‘Lottery’ if the class only received Pre-K funding. 

        Lottery 

        Blended 

 

i) In Column S, if the SSN was not provided, enter the Waiver Reason Code  (i.e. 1, 2, 

3 …) corresponding with the reason selected on the Waiver by the Parent: 

         1 = I need help in obtaining an SSN. 

         2 = I need help replacing a lost SSN. 

         3 = I am awaiting a replacement SSN and will provide when it arrives. 

         4 = I forgot to bring the SSN and will provide within 30 days. 

         5 = I choose not to provide the SSN because …. 

j) In Column T, if the Waiver Reason Code = 5, enter the Waiver Reason Detail 

which is the handwritten reason given by the Parent on the SSN Waiver Form. 

 

NOTE: in columns U-Y, you may indicate ‘Yes’ for as many races as are applicable to 

this student.  You must indicate ‘Yes’ for at least one race value. 

 

4. Repeat step 3 for each student making sure that all students at this site are included. 
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Saving Your Template File(s) 

Once you have verified all data in the file for accuracy, follow the steps below to save two 

different versions of the file.   If you make further changes to the xls file, these steps will need to 

be repeated to keep the xls and csv formats in sync. 

 

1. Click File> Save As> Save as Type> Excel (*.xls).  Use the suggested naming convention: 

<schoolname>_StudentRoster_<mmddyyyy>.xls  

(Example: Idlewood_StudentRoster_08142015.xls) 

 

2.  Click  File> Save As> Save as Type> CSV (Comma Delimited) (*.csv). Use the 

suggested naming convention:     <schoolname>_StudentRoster_<mmddyyyy>.csv      

(Example:    Idlewood_StudentRoster_08142015.csv) 

3. Click ‘Yes’ if you receive any messages regarding the file containing any features that are 

not compatible with CSV. 

 

Note:  Regardless of whether you used the DECAL template or the LSS template, you 

can edit the .xls file as many times as desired before uploading it into Panda, simply by 

double-clicking on the file and opening it in Microsoft Excel.    This may be necessary or 

desirable if you are not entering all students at one sitting or in case you receive multiple 

errors in the upload and find it is easier to edit the xls file than to correct them one by 

one on the Student Error Correction screen.   

Note:  All leading zeros on an SSN will get dropped in Excel due to the SSN column 

being defined as numeric.  The upload process will flag these records as a ‘student 

exception’ since the SSN is now less than 9 digits.  When these records appear on the 

error screen (see pages 23-24) you should simply retype the full 9 digit SSN with leading 

zeros and hit ‘Save’.  

Each time you modify the xls file, you need to repeat Step 1 and Step 2 and resave to 

BOTH the .xls and the .csv formats to keep them in sync.   Use the .xls version for editing 

and the .csv version for uploading.   If you edit the .csv file, it will drop the column 

attributes defined in the xls template and will cause, for example, the leading zeroes to 

be dropped from SSN and from all date fields which will in turn give you additional 

formatting errors the next time you try to upload the file. 
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Uploading Your Completed Student Roster Files  

When your upload file(s) are ready, complete these steps to upload the student roster data. 

1. From the main menu, select View Upload Status. The View Upload Status screen 

displays.  

 

 

 

 

 

2. Click the  button. The Upload File screen displays. 

 

 

3. Click the Browse button, or enter the path to the roster .csv file. 

4. Click the  button. If the roster was successfully uploaded, PANDA displays a 

message that states that the upload was accepted for processing. If the upload was not 

successful, an error message displays. 

5. Click the  button to return to the View Upload Status screen.      
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View Upload Status and Resolve Data Errors 

After you upload your roster files to DECAL, you must check their upload status and 

resolve any data errors.  

1. From the School Year drop-down list, select the current school year. 

2. From the Roster Cycle drop-down list, select the current roster cycle. 

3. Click the  button to view the student file upload status. The file 

status for the selected school year and roster cycle display.  Note that you will need 

to continue to hit the ‘Search/Refresh’ button to refresh the information 

displayed until the file has completed the validation/upload process.    

 

 

These are the possible status values that you should receive during the validation 

process: 

 

 File Format Invalid/File Received – This indicates there is a problem with 

the file layout itself.  Some typical reasons a file layout error occurs are either 

because you’ve uploaded an empty file, an ssn is missing a leading zero, or 

the file contained a class level error (i.e. invalid Class Id). 

 

 Validation In Progress – The roster file that you uploaded has passed the file 

layout validations and now each field is being validated against the data edits 

for that field. 

 

 Student Exception – PANDA found errors in one or more student records. 

 

 Validated - The roster validation is complete and no errors were found or all 

have been resolved. 

 

 Save In Progress – After the roster has been successfully validated and the 

records have loaded to the database, its status changes to Save In Progress 

and the roster is ready to be submitted. 
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4. If you received the ‘Student Exception’ error, clicking on the yellow Select button (as 

shown above next to the File Id) will cause the Student Error Report screen below 

to be displayed which will list each student that was flagged with an error.  

 

 

 

5. Select a student record by clicking the yellow Select button next to the student’s 

name. The Student Error Correction screen displays giving specifics as to which 

field(s) contained invalid information.     

(Note: if the majority of your records have errors, you may find it easier to update 

your .xls file, then resave it to .csv and perform the upload steps again.  When doing 

so and using the same filename, note that by default the ‘Student Exception’ status on 

the file initially uploaded will change to ‘File Format Invalid’ so that you are only 

able to make updates on the Student Error Correction screen for the most recently 

submitted file.  If you have a small number of errors, it will be easier to correct them 

here on the Student Error Correction screen.) 
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6. Review the student’s record and enter your corrections in the Correct Information 

column. Click the button to save your changes. 

 

7. Click the  button record to return to the Student Error report. The 

corrected student record is no longer listed on the report, and the Number of Errors is 

reduced by one. 

 

8. Repeat steps 5-8 for each student listed on the Error Report screen. When you are 

finished, return to the View Upload Status screen.  

 

9. Click the  button. The upload file status should now show Save In 

Progress, and you are ready to submit the roster file by following the instructions on 

the next page.      
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Submitting Your Completed Roster to DECAL 

 

1. When you have entered/verified all of the teacher and student data, click the 

  button at the bottom of the student list. 

If there are any errors a message will appear at the top of the screen.  The roster 

status will not change to Roster Updates Complete until the error has been cleared. 

 

 

2. Click the  button. The Roster Class List screen displays. Notice 

that the lead teacher name, lead teacher credential, and number of kids fields list 

information from the class roster, and that the roster status is now Roster Updates 

Complete. 

 

 

 

3. Click the  button. The Roster Provider Site List screen displays to 

list the rosters that have roster updates complete. 
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4. Read the statement below the site(s) and click the checkbox on the left side of the 

site.  Then scroll down and click the ‘Continue’ button.   The below screen will be 

displayed which you need to read very carefully before proceeding.  

 

 
 

 

5. If you concur that all of the data being entered is true and accurate to the best of your 

knowledge, and that you understand any false, fraudulent or fictitious representation 

is punishable by law and could result in a felony charge, then click the box next to 

‘Accept’.   If you are unsure and need to go back and review more carefully the data 

entered, then click on the box next to ‘Return to Roster’ and wait to submit until you 

have verified all the data is correct. 
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6. After clicking on ‘Accept’, the ‘Submit’ button will then be displayed and you can 

complete the submission process by clicking on the ‘Submit’ button.  The site's 

Roster Status will change to Submitted. You will receive a confirmation email from 

DECAL to inform you that your roster has been successfully submitted to DECAL.  

The email will also give you a count of the number of classes that were submitted.  If 

all classes were not submitted, you will need to go back to the roster to see which 

classes did not submit successfully. 

 

 
 

By Submitting this roster(s) you are asserting via electronic signature 

that the information on the roster(s) is true, complete, and accurate to 

include all available student and teacher information. Social Security 

numbers must be entered unless a parent signed waiver is on file. 
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Printing a Provider Roster Report 

 

After you finish entering your rosters, you can generate the Provider Roster Report. This 

report lists the lead teacher, assistant teacher, and students enrolled in each class on the count 

day.  

To view the Provider Roster report, Adobe® Reader® must be installed on your local 

drive. This software is used to view and print Adobe Portable Document Format (PDF) 

files like the Provider Roster Report, and can be downloaded free of charge. Go to 

http://www.adobe.com and follow the links to download the Adobe Reader. 

 

1. Make sure that you are at the ROS DECAL Site List by selecting View/Edit Roster 

on the blue menu. 

2. Select the current school year from the drop-down list. 

3. Select the current roster cycle from the drop-down list. 

4. Click the  button. Adobe Reader launches to display the 

Provider Roster report in a separate browser window.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.adobe.com/
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Frequently Asked Questions Relating to Rosters: 

 

1. What is the difference in the count date and the due date? 

 

All roster changes/corrections that have occurred up to and through the “count 

date” can be made on the current open roster.  The count date represents the date at 

which the information on the roster is accurate and correct. 

 

Bright from the Start allows extra time to record the roster data, accurate as of the 

count date, on the roster before it must be submitted to our office.  The “due date” 

is therefore the last date that the roster can be submitted without being considered 

late.  

Each roster should show the changes in your class room as of the count date.  So that you 

may continually report changes that occur in your class until the end of the count date, 

you are prevented from submitting your roster prior to the count date.  You may begin 

submitting on or after the count date.  Rosters are required to be submitted by the due 

date which is generally one week following the count date. 

Any changes that occur after the count date will go on the next roster.  No students can 

be added to the roster after the final count date.   

You may find your count dates on the list of Critical Reporting Dates in the Georgia Pre-

K Operating Guidelines.   

 

2. One of my students has withdrawn.  How do I remove the student from the roster? 

On the current open roster, click the yellow select button next to the child’s name.  Then 

click the CLOSE STUDENT button at the top of the screen.  Enter the last date of 

attendance and save. 

 

3. How do I make roster corrections? 

 

You can correct LLP, IEP and GENDER simply by finding the child’s name on the 

roster, click the field that needs to be changed, make the change and save the entry. 

If you need to edit the Category or Transportation fields prior to submission of Roster 1, you can 
click on the student’s name and enter the corrected values. If you need to edit these fields after 
Roster 1 has been submitted, you can now easily edit them on subsequent rosters by Selecting 
the child then clicking on the ‘Chg Trans/Socio Economic’ button at the top of the screen.   Then 
make a choice from the drop-down list.  After you have made your choice, the system will 
prompt you for an effective date.   
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TO DETERMINE THE EFFECTIVE DATES: 

 If you are changing from Category 1 to Category 2 you will enter date that this child became 
INELIGIBLE for Category 1 status. If the child was NEVER eligible, then the effective date should 
be the next day after the begin date in class. 

 If you are changing from Category 2 to Category 1 you will enter the date that this child became 
ELIGIBLE for Category 1 status. If the child was ALWLAYS eligible, then the effective date should 
be the next day after the begin date in class. 

 If you are changing transportation from NO to YES, please enter date that you began providing 
transportation for this child. If you ALWAYS provided transportation for this child then effective 
date should be the next day after the BEGIN date in class. 

 If you are changing transportation from YES to NO, please enter date that you stopped 
providing transportation for this child. If you never provided transportation for this child then 
effective date should be the next day after the BEGIN date in class 
 
To correct ssns, names and/or birth dates please scan and email documents to support your 
request (Ex. Birth certificate or court decree for name changes to panda.finance@decal.ga.gov .   
If you prefer to fax, you can send the documents to 404-651-8576 or 770-357-3815.)  
 

 
4. A parent has decided to provide the social security number (SSN) for a child already on the 

roster.  How do I add the SSN? 
 

SSNs can be added during open roster periods.  Any child without a SSN listed will have the words 
POPULATE SSN in the SSN field on the roster.  After you locate the child on the roster, click on the 
POPULATE SSN link.  Enter the social security number, double check your entry for accuracy and 
save. 

  
 

5. I have completed my updates and I am on the site list screen, but I don’t see a submit button.  
Where is the submit button? 
 
Only one person will see the submit button.  That is the person with the Provider Management 
role. 
 
If you are the Provider Manager and you don’t see the submit button… 
 
The roster must have a status of ROSTER UDPATES COMPLETE before it can be submitted.   
 
From the site list, click the yellow select button next to the site that you want to submit.  You 
should now be on the class list for that site.  Next, click the yellow select button next to the class 
that you want to submit.   (Each class must be updated to ROSTER UDPATES COMPLETE 
separately.)   You should now be on the CLASS ROSTER screen.  The ROSTER UDPATES COMPLETE 
button is located at the bottom of the roster page below the last child on the roster.  Once you 
locate the button, click it to update the status to ROSTER UDPATES COMPLETE. 
 

mailto:panda.finance@decal.ga.gov
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If there are errors a message will appear in red at the top of the page. You will have to fix the 
errors and then click the ROSTER UDPATES COMPLETE button again.   If there are no errors, click 
the RETURN TO CLASS LIST button at the top of the page.  Once you are on the class list, you will 
click the RETURN TO SITE LIST BUTTON at the top of the page. 
 
Once you are on the SITE LIST page and you have a status of ROSTER UPDATES COMPLETE, you 
will begin the submit process by reading the certifications and following the instructions 
provided on each screen.  You will not see the submit button until you have accepted the 
certifications. 
 

              
 

 

 

Important Message: 

 
By Submitting this roster(s) you are asserting via electronic signature that the information on 

the roster(s) is true, complete, and accurate to include all available student and teacher 

information. Social Security numbers must be entered unless a parent signed waiver is on file. 

 


